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1.2 Introduction

This is the 7th version of Multiplot XLN which is the
premier data plotting program for the Commodore Amiga.
It is used in over 30 Universities world wide and Multiplot
graphs have been published in peer reviewed science journals
and presented at international scientific meetings.

Multiplot XLN-S is Shareware. All rights to the source code,
programs and text belong to, and copyrights are held by,
Alan Baxter.

Centenary Institute of Cancer Medicine and Cell Biology,
Locked bag #6, Newtown, NSW 2042, Australia
Fax: (international) 61-2-5656103

StatPack is a link library of statistical functions and
is available for licence. It is copyright Scientific
Programming of Interactive Applications, Olivia Wüthrich-
Martone and Charles Wüthrich.
email: wuethri@amiga.icu.net.ch

Summary

Registration and Distribution Conditions

Legal Disclaimer

1.3 Registration and distribution

Multiplot is not in the public domain. It is now
(from XLNe) shareware and a shareware fee is requested.

Two versions are currently available.
Multiplot XLN-S provides both graphing facilities and
statistical analysis and can be registered for
$40 USD, #30 UK or $50 ASD.

Multiplot XLNg provides the same graphing facilities,
but does not contain the StatPack library functions.
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It can be registered for $30 USD, #23 UK or $35 ASD.

Registrations should be sent to:
Dr Alan Baxter,
Centenary Institute of Cancer Medicine and Cell Biology,
Locked bag #6, Newtown, NSW 2042, Australia,

Personal cheques are accepted when drawn on Australian,
British or US national banks. Payments drawn on other
foreign banks are not accepted due to excessive banking
charges.

The shareware fee entitles the licensee to the most
recent version of Multiplot, on-line hypertext document-
ation, an ARexx Companion Disk containing extra utilities
and a tutorial on using ARexx with Multiplot, free bug
fixes and discount upgrades. The ARexx Companion Disk
and the Amiga Guide documentation are not Shareware,
and may not be copied or distributed without the author’s
permission.

Multiplot may be freely distributed, but not included in a
commercial package without express consent of the author.
It is periodically released to Mr Fred Fish, who is licensed
to distribute it in any form he sees fit providing the
distribution package contains documentation and examples.
This package may then be compressed and posted on any
electronic distribution service.

1.4 Legal Disclaimer

These programs are in no way designed or intended for
professional use. Any damages or losses resulting from
inappropriate application of any or all of this distrib-
ution whether accidental or intentional, are not the
responsibility of the author, his wife, son, agent,
mother or (much missed) labrador; and should not, under
any circumstances, be compounded by attempting long and
fruitless legal action.

All rights to the documentation, source code and programs
are reserved.

The inclusion of the
PLT: Device

with
Multiplot in no way implies any change in, or affects the
distribution conditions of that package. Please read the
documentation provided with PLT: for further information.

AmigaGuide, AmigaGuide.info, amigaguide.library, WDisplay,
WDisplay.info (c) Copyright 1991-93 Commodore-Amiga, Inc.
All Rights Reserved. Reproduced and distributed under
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license from Commodore.

AMIGAGUIDE SOFTWARE IS PROVIDED "AS-IS" AND SUBJECT TO
CHANGE; NO WARRANTIES ARE MADE. ALL USE IS AT YOUR OWN
RISK. NO LIABILITY OR RESPONSIBILITY IS ASSUMED.

The StatPack functions are included with the permission of
Olivia Wüthrich-Martone and Charles Wüthrich of Scientific
Programming of Interactive Applications.

1.5 Summary

Multiplot XLN is professional standard fully intuitive data
plotting program. It plots data points as (x,y) co-ordinates
with or without x or y error bars.

It can plot an unlimited number of sets with any
number of data points using colour, line type, line weight,
point shape and point size to represent the different sets.
A set may be joined by a line or plotted as discrete points.
Data may be impulse plotted, scatter plotted, or shown as a
histogram or step graph. Additions to the data may be made
in the form of lines of best fit (logarithmic, exponential,
linear and polynomial) and data smoothing utilising modified
open b-splines or averaging filtration. The input file for
Multiplot is a simple textfile and my be created in any
ASCII text editor or saved from any spreadsheet. Multiplot
supports the clipboard, and data input may be achieved
solely through it.

Multiplot has a full ARexx interface which provides
potential for a wide variety of data manipulations
including statistical analysis.

Multiplot fully supports on-line Amiga Guide documentation
and the ’Help’ key.

Output may be in any of the following formats: IntroCAD,
Draw, mCAD, IFF, Revised Hewlett-Packard Graphics Language
(HPGL/2), Encapsulated Postscript (EPSF) or Postscript. The
graph can be printed to any workbench printer by transparent
use of the

PLT: Device
. Multiplot directly

supports the HP LaserJet III and Postscript laser printers
such as the Apple Laser printer.

1.6 Requirements
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*Workbench 2.0 (or higher) including:
Maths libraries,
Assignment of ENV:, T:, and CLIPS:.
The C: directory must contain the files c:mount and

c:type.

*The
PLT: Device
is necessary for printing.

It consists of:
-PLT:-handler in the L: directory
-The mountlist entry for PLT: added to the
devs:mountlist (WB2.0) OR The device driver to
be placed in the storage/dosdrivers directory
(> WB2.0).

-Assignment of the PLTDATA: directory containing
PLT fonts.

*The PLT: device requires that a printer has been selected
in the printer preferences window and the printer choice
saved. The "Generic" printer driver is sufficient, but must
be selected and the selection saved from within the printer
preferences program. Trying to use PLT: without defining a
printer will result in a software error (number 80000005).

*At least 1Mb RAM.

*The directory which contains Multiplot must contain a
subdirectory called "MPlot_support" (without the quotes)
which must contain the files "intro.img", "txt_2_icad",
"plot2draw" and "HPGL2PS" (without the quotes).

*The file "MPlot.def" should either be in the
"MPlot_support" directory, or in the S: directory.

*
Zounds!
requires that the files "say.znd",

"ask.znd", "ding.znd" and "zounds.img" be in the
"MPlot_support" directory.

* ARexx support requires that rexxmast be running, and RC
be in the SYS:rexc directory.

1.7 Installation

Multiplot must be installed from the Workbench using the
Install utility which is provided on the installation
disk. This program will prompt for a directory in which
you wish to store Multiplot. As several system files are
copied during installation, it is important that the
computer has been booted up on the Workbench you intend
to use when running Multiplot.
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1.8 The PLT: Device

PLT: is a file-handler that emulates a plotter by
accepting HP-GL commands, creating a raster image,
and then dumping it to any Preferences supported
graphics printer. Both Multiplot’s Workbench printing
and the

Print Preview
menu

option are mediated by PLT: interpretation of HP-GL
commands.

Summary

Legal restrictions

Requirements

Installation

Using The PLT: Device

1.9 PLT: Device Summary

PLT: is a file-handler that emulates a plotter by accepting
HP-GL commands, creating a raster image, and then dumping it
to any Preferences supported graphics printer. The current
resolution set with preferences is used, allowing PLT: to
make full use of a printer’s capability.

PLT: accepts virtually all of the standard HP-GL commands,
including scaling and text. The commands that were not
implemented are those which are generally contained in an
extended graphics cartridge, such as: circles, arcs, filled
regions, etc.

1.10 The Zounds! Auditory Cuing System

Auditory cuing systems (ACS) are standard interfaces of
sounds triggered by actions within application programs.
The sounds are used to inform the user of a change in
status of the program. Particular sounds are used to
identify specific changes and become part of the user
interface helping to orient the user.

Zounds! is a state of the art ACS developed for the
Amiga. It is available for license to other developers and
its incorporation into other application programs is
encouraged by the author. It provides a set standard
alerting sounds that are triggered whenever the program
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unexpectedly has something to tell the user. Sounds are
not triggered directly as a result of user selection of
icons, objects or menu selections.
A message requester triggers a sound like "Didlepom"; a
falling tone not dissimilar to the falling tones used in
speech when stating fact. A rising tone, "Bombidit" is
triggered by requesters that are asking for a response from
the user. The rising tones reflect those used in speech
when asking a question.

The Zounds! volume is set at application start-up either
in the command line when the application is started from the
CLI or by setting the tool types appropriately in the icon
when using the Workbench. If the volume is set to 0 at
start-up, Zounds! is disabled.

Example:
From the CLI >Multiplot VOLUME=0
From the Workbench, set Tool Types to VOLUME=0

Zounds! is completely user configurable. The sound
samples used by Zounds! have names ending in the post fix
.znd, are stored in a support directory (MPlot_support),
and are in the standard Amiga 8SVX IFF format. These samples
may be replaced by sounds chosen by the user.

1.11 Starting Multiplot

Multiplot can be started from either the Workbench or from
the Command Line Interface (CLI). The same options are
available either as Workbench tool types or as command line
options.

Workbench Startup Options

CLI Startup Options

1.12 Workbench Startup Options

The workbench start-up options are defined in the Multiplot
icon and are set as tool types. The following options are
available:

SCREENMODE Keyword to be followed by one of the following:

HIRES Indicates 640 pixel wide
(+ overscan) mode.

SUPER Indicates 1280 pixel wide
(+ overscan) mode.
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PRODUCT Indicates VGA compatible mode.

LACE May be or’ed (|) with any of the
above modes to double the vertical
resolution

A2024 Supports the Commodore A2024
monitor.

TENHERTZ May be or’ed (|) with A2024 to
indicate sync speed.

FIFTEENHERTZ May be or’ed (|) with A2024 to
indicate sync speed.

If the SCREENMODE tooltype is not included, Multiplot will
clone the characteristics of the Workbench screen.

Example: SCREENMODE=HIRES|LACE produces 640 x
400/512 screen.

SCREENDEPTH Keyword to be followed by screen depth in
planes. Currently only 1 to 4 planes are available in HIRES
and 1 to 2 planes in productivity. One bit plane provides 2
colours, 2 bit planes provides 4 colours, 3 bit planes
provides 8 colours and 4 bit planes provides 16 colours.

Example: SCREENDEPTH=3 produces an 8 colour screen.

SCREENWIDTH Keyword to be followed by width of screen in
pixels. Screens wider than the current visible size are
opened as autoscroll screens.

Example: SCREENWIDTH=720 produces maximum horizontal
overscan for a hires screen.

SCREENHEIGHT Keyword to be followed by height of screen in
pixels. Screens taller than the current visible size are
opened as autoscroll screens.

Example SCREENHEIGHT=484 produces maximum vertical
overscan for an NTSC interlaced screen.

STARTPRI Keyword to be followed by priority the Multiplot
process should be run at. In general, priority should be
between -5 and 5 to avoid conflicts with other currently
active processes. Multiplot must be run at a lower priority
than the

PLT: Device
to avoid a scheduling

lock-out.
Example: STARTPRI=3 results in slightly faster

execution.

PUBSCREEN Keyword to be followed by the name of a public
screen for Multiplot to open on. Note that the public screen
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name need only include the first word of the screens name,
and that the name is case sensitive. For example Workbench
is recognised but WORKBENCH is not.

Example: PUBSCREEN=Workbench results in Multiplot
running on the workbench instead of its own screen.

STARTUP Keyword to be followed by name of an ARexx macro
to be run from

The Data Selection Window
at start-up.

Example: STARTUP=Rexx/Loadtable.mpt runs macro on
start-up.

PORTNAME Keyword to be followed name for ARexx port when
opened. The default name is MULTIPLOT.nn where nn is the
lowest available number producing a unique port name.

Example: PORTNAME=TAWNY Names the ARexx port for
Multiplot "TAWNY"

SETTINGS Keyword to be followed by the name of a file
containing initial settings. If not set, the file
MPlot_support/MPlot.def is read. The defaults file defines
the screen colours, printed pen thicknesses, axes (number,
type, range), grid and tics, plot labels and locks.

Example: SETTINGS=s:MyNiceColours Loads settings
from named file.

QUIET Prevents opening of the introduction WINDOW. It is
useful for remote start-up of Multiplot especially if
invoked from an ARexx macro, or if you are just sick of
seeing the introduction WINDOW.

Example: QUIET

VOLUME Sets the volume of
Zounds!

Auditory
Cuing System to a value between 0 and 64. Setting a volume
of 0 switches off Zounds! completely.

Example: VOLUME=0 Switches off Zounds! Auditory
Cuing System.

PSFONT Sets the postscript output font to that named. The
keyword PSFONT must be followed by one of:

Times-Roman
Helvetica
Helv-Narrow
AvantGarde
Bookman
Palatino
ZapfChancery
Courier
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Example: PSFONT=Times-Roman Switches both
postscript printed output and EPSF output
fonts to Times-Roman

PSPAGE Sets the postscript printed page size, ensuring
correct placement of graphs on pages with different aspect
ratios. The keyword PSPAGE must be followed by one of:

A Sets USA page size A
4 Sets to international standard A4 page size

Example: PSPAGE=A Sets postscript page size to USA
page size A.

1.13 CLI Startup Options

The CLI start-up options are defined on the command line
and are summarised in the template:

Multiplot FILES, QUIET/S, PUBSCREEN/K, PORTNAME/K,
STARTUP/K, SETTINGS/K, SCREENDEPTH/N,
SCREENWIDTH/K/N, SCREENHEIGHT/K/N, SCREENMODE/K,
STARTPRI/K/N, VOLUME/K/N, PSPAGE/K, PSFONT/K

Where:
,(comma) indicates no arguments or separates

arguments,
/K indicates the keyword is required,
/S indicates a switch keyword, and
/N indicates a numerical argument is required.

These keywords provide the following options:

FILES Keyword to be followed by name of file to be loaded on
invocation. If file was written by Multiplot it will be
autoloaded. If this argument is used together with the QUIET
argument, Multiplot will open a Plot window on start-up.

Example: Multiplot FILES Data/Eric.dat

SCREENDEPTH Keyword to be followed by screen depth in
planes. Currently only 1 to 4 planes are available in HIRES
and 1 to 2 planes in productivity. One bit plane provides 2
colours, 2 bit planes provides 4 colours, 3 bit planes
provides 8 colours and 4 bit planes provides 16 colours.

Example: Multiplot SCREENDEPTH 3 produces an 8
colour screen.

SCREENWIDTH Keyword to be followed by width of screen in
pixels. Screens wider than the current visible size are
opened as autoscroll screens.

Example: Multiplot SCREENWIDTH 720 produces maximum
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horizontal overscan for a hires screen.

SCREENHEIGHT Keyword to be followed by height of screen in
pixels. Screens higher than the current visible size are
opened as autoscroll screens.

Example: Multiplot SCREENHEIGHT 484 produces maximum
vertical overscan for an NTSC interlaced screen.

SCREENMODE Keyword to be followed by one of the following:

HIRES Indicates 640 pixel wide by
200/256 high (+ overscan)
mode.

HIRESLACE Indicates 640 pixel wide by
400/512 high (+ overscan)
mode.

SUPER Indicates 1280 pixel wide by
200/256 high (+ overscan)
mode.

SUPERLACE Indicates 1280 pixel wide by
400/512 high (+ overscan)
mode.

VGAPROD Indicates VGA compatible
mode.

VGAPRODUCTLACE Indicates interlaced VGA
compatible mode.

A2024TENHERTZ Supports the Commodore
A2024 monitor at sync speed
of 10Hz.

A2024FIFTEENHERTZ Supports the Commodore A2024
monitor at sync speed of
15Hz.

If the SCREENMODE keyword is not included, Multiplot will
clone the characteristics of the Workbench screen.

Example: SCREENMODE HIRESLACE produces 640 x
400/512 screen.

STARTPRI Keyword to be followed by priority the Multiplot
process should be run at. In general, priority should be
between -5 and 5 to avoid conflicts with other currently
active processes. Multiplot must be run at a lower priority
than the

PLT: Device
to avoid a scheduling

lock-out.

Example: Multiplot STARTPRI 3 results in slightly
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faster execution.

PUBSCREEN Keyword to be followed by the name of a public
screen for Multiplot to open on. Note that the public screen
name need only include the first word of the screens name,
and that the name is case sensitive. For example Workbench
is recognised but WORKBENCH is not.

Example: Multiplot PUBSCREEN Workbench results in
Multiplot running on the workbench instead of its
own screen.

STARTUP Keyword to be followed by name of an ARexx macro
to be run from

The Data Selection Window
at start-up.

Example: Multiplot STARTUP Rexx/LoadTable.mpt runs
macro on start-up.

PORTNAME Keyword to be followed name for ARexx Port when
opened. The default name is MULTIPLOT.nn where nn is the
lowest available number producing a unique port name.

Example: Multiplot PORTNAME TAWNY Names the ARexx
port for Multiplot "TAWNY"

SETTINGS Keyword to be followed by the name of a defaults
file containing initial settings. If not set, the file
MPlot_support/MPlot.def is read. The defaults file defines
the screen colours, printed pen thicknesses, axes (number,
type, range), grid and tics, plot labels and locks.

Example: Multiplot SETTINGS s:MyNiceColours Loads
settings from named file.

QUIET Prevents opening of introduction WINDOW. Useful for
remote start-up of Multiplot especially if invoked from an
ARexx macro, or if you are just sick of seeing the
introduction WINDOW.

Example: Multiplot QUIET

VOLUME Sets the volume of
Zounds!
Auditory Cuing System to

a value between 0 and 64. Setting a volume of 0 switches off
Zounds! completely.

Example: VOLUME 0 Switches off Zounds! Auditory
Cuing System.

PSFONT Sets the postscript output font to that named. The
keyword PSFONT must be followed by one of:

Times-Roman
Helvetica
Helv-Narrow
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AvantGarde
Bookman
Palatino
ZapfChancery
Courier

Example: Multiplot PSFONT Times-Roman Switches both
postscript printed output and EPSF output fonts to
Times-Roman

PSPAGE Sets the postscript printed page size, ensuring
correct placement of graphs on pages with different aspect
ratios. The keyword PSPAGE must be followed by one of:

A Sets USA page size A
4 Sets to international standard A4 page size

Example: Multiplot PSPAGE A Sets postscript page
size to USA page size A.

1.14 Windows Available in Multiplot

Interaction with Multiplot achieved through menu, gadget,
keyboard or ARexx control of individual windows. Each window
has its own specialised purpose, options, keyboard shortcuts,
and ARexx commands. The windows available are:

The Introduction Window

The Plot Window

The Data Selection Window

The Custom Plot Window

The Edit Axis Window

The Edit Point Window

The Edit Text Window

The Print Set-up Window
The About Window

The Pull Window

The Ask Window

The Message Window
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1.15 The Introduction Window

This window opens on start-up. It may be closed by clicking
either mouse button or hitting any key on the keyboard.

This window may be prevented from opening by using the QUIET
start-up option. It is important that the QUIET option be
used if Multiplot is invoked from an ARexx script, as this
window does not have an ARexx interface.

ARexx Commands are not supported.

1.16 The Plot Window

This window opens on starting Multiplot. While it is active,
an extensive rage of

Menu Selections
are available from the

menu bar at the top of the screen.

Data can be entered by starting Multiplot with a project
file to plot, by loading a file from

The Data Selection Window
, or by entering the data by

hand in
The Data Entry Window
.

If a data file has been loaded at startup, it will be
visible as either a default plot of your data or in the
previously saved format (if loaded from a Multiplot File
Format 2 file). The default plot will show lines and points
with a different colour and point type for each data set.

The Plot Window
contains 5 regions. The central area is

where the data is represented. The left margin contains
the Y values and Y axis label of any left hand Y axes. The
right margin contains the Y values and Y axis label of any
right Y axes as well as any plot legends. The lower margin
contains the X values and the X axis label and the top
margin may contain the plot title.

On starting Multiplot, the pointer action is set to
SELECT. In this mode it is possible to select objects to
alter their characteristics. A data set may be selected by
clicking the left mouse button near one of its points. A
legend may be selected by clicking the left mouse button
on it. In this mode, double clicking on an object will
call up an edit window to change some feature of the object.
Double clicking on a point in a data set will call up
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The Custom Plot Window
, and allow you to change line type,

colour, point type and point size of the data set. It
will also allow you to skip rendering that set or delete
it completely.

Double clicking on a legend will call
The Edit Text Window
,

to allow you to edit the text in the legend. Double clicking
in the top margin will call up

The Edit Text Window
to allow you to edit or add a title. Double clicking on an

axis tic value allows you to edit the text of that value.
This text will be reset on rescaling the axis unless the
axis values lock is set in

The Edit Axis Window
.

Double clicking the left mouse button beneath the X Axis
calls up the

The Edit Axis Window
to edit the X Axis,

while double clicking to the right of a right hand Y Axis or
to the left of a left hand Y Axis produces

The Edit Axis Window
to edit the appropriate Y AXIS.

The Edit Axis Window
allows you to set the minimum and

maximum tic values, the number colour and type of tics,
and edit the axis label.

In the SELECT mode, it is possible to move text around the
screen by pressing the left mouse button while the pointer
is over the text, holding it down, and dragging the text to
the desired location. If the movement is small, a screen
refresh may need to by forced by selecting

The Redraw Menu Option
. Several blocks of text can be moved

together, without changing their relationship to each other
by group selecting them. Click on one block of text, hold
down the shift key and select the others, then without
releasing the left mouse button, drag the blocks of text to
their new location. To move text vertically without any
horizontal movement, select (or group select) the text, and
while still holding down the left mouse button, press and
hold down the ’v’ key on the keyboard. Then drag the text
to its new location. To move text horizontally without any
vertical movement, select (or group select) the text, and
while still holding down the left mouse button, press and
hold down the ’h’ key on the keyboard. Then drag the text
to its new location. To return Axis values to their default
positions (sometimes necessary if changes to margins or
other formatting has displaced the value labels from the
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tics on the axes) select
The Update Menu Option
.

Single data points can be moved in a similar manner. To
select a data point, click the left mouse button over it
while holding down the Ctrl key. Several data points may
be group selected by holding down the shift key as well
as the Ctrl key while selecting the points. To move data
points vertically without any horizontal movement,
select (or group select) the points, and while still
holding down the left mouse button, press and hold down
the ’v’ key on the keyboard. Then drag the points to
their new location. To move points horizontally without
any vertical movement, select (or group select) the points,
and while still holding down the left mouse button, press
and hold down the ’h’ key on the keyboard. Then drag the
points to their new location.

Multiple items of different natures may be group selected
together. It is possible to select whole data sets, single
points and text in one go. Note however that only data
points and text can be moved. Objects can be aligned by
group selecting the objects to be aligned and then choosing
the

The Align Vertical Menu Option
or

The Align Horizontal Menu Option
.

A curve reader is also available in the SELECT mode. If
the Alt key is held down when the left mouse button is
pressed, the co-ordinates of the point indicated will be
given. The curve reader automatically compensates for log
axes, zooming and sliding.

The pointer action can be set to ZOOM or SLIDE by
selecting these subitems from the Pointer Action option in

The Edit Menu
. The action of the pointer in these modes is

described in CHAPTER 4.
The menus available from

The Plot Window
are

Project
which relates to the loading, saving and printing of

plots,
Edit
which allows you to delete, copy, paste,

import and export data and text,
Actions
which allows

modification of the plot, resizing, shifting and zoom,
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Options
which changes the screen palette, axes, and cross

hairs;
Functions
which allows special actions like

data smoothing, line fitting and data sorting and provides
access to ARexx macros; and

Statistics
which provides

functions for describing and comparing data sets.

Global
and

Custom Plot Window ARexx Commands
are supported.

1.17 The Data Selection Window

This window is for indicating the location and format of
a data file to be input into Multiplot.

The Data Selection Window
may be opened by selecting

The Open File Menu Option
,
The Add File Menu Option
or
The New Graph Menu Option
. The following is a list of the

major buttons within
The Data Selection Window
and their

functions.

The FILE NAME box contains the name of the data file to
be plotted. The text within this box can be edited by
clicking the left mouse button while the pointer is over
the box, and then typing the new file name. If the FILE
NAME box does not contain a file name, then Multiplot will
open a new graph with no data loaded. Data can then be
entered manually or pasted from the clipboard.

The PATH button will call up a file requester to help with
browsing through directories trees looking for wanted data
files. The selected file name is pasted into the FILE NAME
box when the requester is closed.

The NONE button will clear the FILE NAME box.

The CONTINUE button accepts current settings, closes
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The Data Selection Window
and loads the data from the file

indicated in the FILE NAME box into
The Plot Window
for

rendering the default graph.

Beneath the file selection box are six other boxes to
indicate what column the X, Y and Error values are in. A ’0’
indicates value is absent. For example if the Y Error box
has a ’0’, no error bars will be plotted. If the X box has
a ’0’, the X values will be assumed to start at 0 and
increase by 1 with each data point. If the Low Error box
has a ’0’ but the Error box contains a valid column number,
the error bars will be assumed to be symmetrical about the
data point. If however, the Low Error column is defined,
asymmetrical error bars may be plotted. When satisfied with
the file and column specification, hit the return key or
click on the CONTINUE button and the selected data file will
be checked to ensure it has the number of columns required,
and loaded if suitable.

If the file you identified when invoking Multiplot has
previously been written by Multiplot, it will autoload
without presenting you with

The Data Selection Window
.

Global
and

Data Selection Window ARexx Commands
are supported.

1.18 The Custom Plot Window

This window can be invoked either by double clicking the
left mouse button while the pointer is over any of the
data set’s points and Multiplot is in SELECT mode, or by
selecting

The Redefine Plot Menu Option
.

The Custom Plot Window
allows you to select plot colours,

line type, Y-axis and whether data is plotted as a line,
series of points, both, a histogram, or a step plot.
If points are drawn, the point size and point type can be
selected.

The COLOUR bar displays the data set colour. The colour
is selected by clicking the left mouse button over the
COLOUR bar which then cycles through the available options.
Note that in monochrome output, the line thickness of each
colour (or "pen") can be set from within
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The Print Set-up Window
. This enables the user

to assign different pen weights to either different data
sets or different graph elements. For example, the axis tic
marks could be in the finest pen, the data sets in a medium
weight pen, and the axes in the thickest pen.

The POINT SIZE box displays the current point size which
can be changed either by clicking the left mouse button over
either the up or down arrows, or by clicking within the
POINT SIZE box to edit the value directly. If the pointsize
is set to ’0’, each point will print as the smallest
possible point achievable by the output device. For example
a point of size ’0’ would print on an Apple LaserPrinter as
a dot 1/300th inch in diameter.

The LINE TYPE box displays the current line type that
data set is rendered in. The line type is selected by
clicking the left mouse button over the LINE TYPE box which
then cycles through the available options.

The PLOT TYPE selection is highlighted in the array of
options. Data may be plotted as points, lines, points and
lines, step graph (with or without points) and impulse
plots. The step graph is of the form change in X followed
by change in Y. The point type may be selected from the
panel of six mutually exclusive buttons on the right of
the window.

The POINT TYPE selection is highlighted in the array of
options. The point type is selected by clicking the left
mouse button over the button displaying the desired point
type.

The AXIS box defines the Y axis the data set will be
plotted in. If the current graph has only a single Y Axis,
this box will be blank. Otherwise, the Y Axis is indicated
by moving the marker within the box.

The CONTINUE button will accept changes and proceed to
the Plot window where the plot is rendered.

The SKIP button will skip the data set, so that it will not
be plotted when

The Plot Window
is updated. The missing data

set can then be recalled by selecting

The Redefine Plot Menu Option
, and pushing the CONTINUE

button when presented with the data set.

The KILL button is similar to the SKIP button but its
effects are permanent. A single level of undelete is
supported and dead data set can be revived with
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The Undelete Menu Option
option providing nothing else

has been deleted subsequently. The STOP button closes
the Custom Plot window without accepting any changes.
If the window was opened by selecting

The Redefine Plot Menu Option
, the STOP button

will also skip all remaining data sets without presenting
the Custom Plot window for them.

Global
and

Custom Plot Window ARexx Commands
are supported.

1.19 The Axis Window

This window can be called by double clicking the left mouse
button over the axis to be edited with the Mouse Action menu
option set to SELECT mode. It allows the following
characteristics of the axis to be edited:

*Position (RIGHT or LEFT) of the graph may be set if
there are more than one Y axes and the current axis being
edited is any Y axis other than the first one. To add a
right hand Y axis to a graph, select

The Add Menu Option
Axis selection, then edit the new (upper) Y axes by double

clicking over its left margin, and set the position to
the right side by activating the RIGHT position button.

*Minimum and maximum axis values. The axis scale
may be reversed by placing the higher value in the minimum
value box and the lower value in the maximum value box.
This results in mirror image reversal of the data.

*The number of major tics/grid lines. The number of
major subdivisions may vary from 1 to 20.

*Colour of major tics/grid lines. Note that in
monochrome output, the line thickness of each colour (or
"pen") can be set from within

The Print Set-up Window
. This

enables the user to assign different pen weights to
different graph elements. For example, the axis tic marks
could be in the finest pen, the data sets in a medium
weight pen, and the axes in the thickest pen.

*Line type of major tics/grid lines.

*The number of minor tics/grid lines. The number of
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minor subdivisions may vary from 1 to 10.

*Colour of minor tics/grid lines. Note that in
monochrome output, the line thickness of each colour
(or "pen") can be set from within

The Print Set-up Window
.

This enables the user to assign different pen weights to
either different data sets or different graph elements.
For example, the axis tic marks could be in the finest pen,
the data sets in a medium weight pen, and the axes in the
thickest pen.

*Line type of minor tics/grid lines.

*Axis scale type. The axes may be set as linear or
logarithmic independently allowing log/lin, lin/log,
log/log and lin/lin plots.

*The axis label.

*Scale Lock. A lock may be set preventing rescaling
of the axis.

*Values Lock. A lock may be set preventing
overwriting of the axis values.

Note that the current axis settings are taken into account
for linear fits of data. For example, if the Y axis is
logarithmic and the X axis linear, an exponential fit is
produced (a straight line on a lin/log scale). If the X axis
is logarithmic and the Y axis linear, a log fit is produced
(a straight line on a log/lin scale). Log/log and true
linear fits are also available.

Global
and

Edit Axis Window ARexx Commands
are supported.

1.20 The Edit Point Window

This window may be called up for any data point by holding
down the Ctrl key and double clicking the left mouse button
over the desired data point with the Mouse Action menu
option set to SELECT mode. This window allows the X and Y
values of a point to be individually set, and the X and Y
error bars to be altered. Note that the error bars need not
be symmetrical, and one direction error bars are supported.

Global
and
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Edit Point Window ARexx Commands
are supported.

1.21 The Edit Text Window

This window is called mode by double clicking the left mouse
button over some text or selecting some text and activating

The Add Menu Option
Text selection while the mouse action

is in SELECT; or by clicking the left mouse button on the
LABEL button in

The Edit Axis Window
.

It allows the alteration and creation of the plot title,
axis labels and values, data set legends and added text.

The TEXT Box displays the text and allows direct editing
by clicking the left mouse button within the TEXT box and
typing in the new text.

The FONT button calls up a font requester to allow
browsing of available fonts and to preview them before use.

The FONT box describes the current font selection and
allows direct changes to be made without opening the font
requester.

The POINT SIZE box describes the current font size
selection and allows direct changes to be made without
opening the font requester.

The CONTINUE button accepts current changes and closes

The Edit Text Window
.

The STOP button rejects current changes and closes

The Edit Text Window
.

Global
and

Edit Text Window ARexx Commands
are supported.

1.22 The Print Set-up Window
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This window is called by selecting

The Print Setup Menu Option
.

It allows the selection of print orientation, size and
position of the current graph.

The SIZE slide bar sets the size of the plot on the
printed page. The default setting is for the plot to fill
the page. Clicking within the slider’s run allows changes
in size from 10% to 100% in 10% increments. Dragging the
slider allows finer control of the plot size.

The ORIENTATION button controls the orientation of the
plot. Default is for the plot to be printed in landscape
(with the page lying down). Orientation may be toggled
between landscape and portrait by clicking the left mouse
button over the icon which represents the current setting.

The position of the plot on the page can be set by
dragging the square within the POSITION box. The square
represents the plot and the border of the box represents
the full page.

Pen descriptions for the
PLT: Device
may be defined

from this window. Each pen is described by the COLOUR bar on
the right hand side of

The Print Set-up Window
.

The pen currently being edited is identified by its
colour and may be chosen by clicking the left mouse button
over the COLOUR bar to cycle through all the pens available.
The number shown immediately below the COLOUR bar indicates
the pen thickness. The pen thickness may be set for each
pen, will be used when printing via PLT:, and is saved in
the defaults file. This enables the user to assign different
pen weights to different graph elements. For example, the
axis tic marks could be in the finest pen, the data sets in
a medium weight pen, and the axes in the thickest pen.

The SPOOL button toggles on and off the print spool
which allows printing to continue in the background while
you return to editing a new plot. Once the print spool has
been started, Multiplot may even be quit without
interrupting printing. To stop printing a spooled file,
click the left mouse button on the "close gadget" (top left
corner) of the

PLT:
window on the WorkBench.

The PRINT button selects which of the currently open
graphs should be printed on the page when
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The Print Menu Option
. Only graphs in which the

PRINT button is highlighted in
The Print Set-up Window
will print. A graph may be "turned off" by deselecting

this button.

Global
and

Print Set-up Window ARexx Commands
are supported.

1.23 The Data Entry Window

This window may be opened by selecting the Add DataSet
subitem of

The Add Menu Option
or by selecting an

existing data set and then choosing the

The View Data Menu Option
.

This window is for entering X and Y data values of an
individual data set. The central area of the window contains
a display of the points already entered in the data set,
with a scroll bar at the right hand side of the box to
scroll rapidly through a large data set. The row of text
entry boxes below this area is for entering new values.
Activate the left hand text entry box first by clicking
the left mouse button once while the pointer is over it,
to enter an X value.

Hitting the return key will automatically move between
the text entry boxes, and will accept the new data point
when it has been entered.

Above the data display area, on the right hand side, are
two cycle buttons which determine what error values are
required to be entered - and which are displayed in the
display area. By making the appropriate selection,
symmetrical or asymmetrical errors in X and Y can be
entered.

The CONTINUE button at the bottom of the window will accept
any changes, and replot the graph while the STOP button
will abort any alterations, returning you to the original
plot.

Global
and
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Data Entry Window ARexx Commands
are supported.

1.24 The Co-ordinates Window

This window may be opened by selecting

The Coordinates Menu Option
. It displays the pixel

location of the pointer within the currently activated

Plot Window
.

ARexx Commands are not supported.

1.25 The Description Window

This window is opened by selecting a data set while the

Graph Type
is either Scattergram or Box Plot, and

choosing
The Description Menu Option
.

It describes the following attributes of the selected data
set:

Count
Range
Minimum
Maximum
Mean
Median,
Variance
Standard Deviation
Standard Error
Coeficient of Variation
Sum
Sum of squares
Corrected sum of squares
Skewness
Kurtosis

ARexx Commands are not supported.

1.26 The Percentiles Window
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This window is opened by selecting a data set while the

Graph Type
is either Scattergram or Box Plot, and

choosing
The Percentiles Menu Option
.

This window displays the count, minimum and maximum values of
the selected data set as well as a spread of five centile
values and the number of points which exceed the highest
centile or fall below the lowest. By default, the centiles
calculated are: 10th, 25th, 50th (the median), 75th and the
90th. The centiles calculated may be edited to those of
interest by clicking within any of the text entry boxes
displaying the centile to be calculated.

ARexx Commands are not supported.

1.27 The One Sample t Test Window

This window is opened by selecting a data set while the

Graph Type
is either Scattergram or Box Plot, and

choosing
The One Sample t Test Menu Option
.

This window displays the mean and variance of the selected
data set. The population mean may be entered into the text
entry box, and the t value, degrees of freedom and
two-tailed probability calculated by the One Sample t Test.

ARexx Commands are not supported.

1.28 The Two Sample t Test Window

This window is opened by selecting two data sets while the

Graph Type
is either Scattergram or Box Plot, and

choosing either the paired or unpaired subitems of
The Two Sample t Test Menu Option. Select the
two data sets by selecting the first one (single click of
the left mouse button while the pointer is over a data point
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from the data set), and then holding down the shift key
while selecting the second set.

Paired t Test
The Paired t Test can only be used to compare two data sets
of equal numbers of points in which each pair corresponds
to pairs of measurements. It calulates the number of pairs,
the degrees of freedom, the mean of the differences betweeen
each pair of values, the variance of the differences
betweeen each pair of values, the t value and the two-tailed
probability.

Unpaired t Test
The Unpaired t Test can be used to compare two data sets of
unequal sizes. It calulates the mean, variance and standard
error for each of the selected data sets as well as the
degrees of freedom, the t value and the two-tailed
probability.

ARexx Commands are not supported.

1.29 The Mann-Whitney U Test Window

This window is opened by selecting two data sets while the

Graph Type
is either Scattergram or Box Plot, and

choosing The Mann-Whitney U Test Menu Option. Select the
two data sets by selecting the first one (single click of
the left mouse button while the pointer is over a data point
from the data set), and then holding down the shift key
while selecting the second set.

This window displays the number of points and the sum of the
ranks for the two data sets selected as well as the number
of tied ranks, the U and U‘, Z and corrected Z statistics
and the two-tailed probability.

ARexx Commands are not supported.

1.30 The Contingency Table Window

This window is opened by selecting the

The Contingency Table Menu Option
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.

This window provides a four-fold table of text entry boxes
in which the frequencies of two mutually exclusive events
(A and B) are entered for two samples (1 and 2). The
following values are calculated: the sums of the
numbers of events in each row and column, the total
number of events; the expected frequency, row percentage,
column percentage and global percentage of each cell;
the Chi-square and probability values with and without
Yate’s correction; and the Woolf G, Pearson and Phi
Coeficients.

ARexx Commands are not supported.

1.31 The Fisher’s Exact Test Window

This window is opened by selecting the

The Fisher’s Exact Test Menu Option
.

This window provides a four-cell table of text entry boxes
in which the frequencies of two mutually exclusive events
(A and B) are entered for two samples (1 and 2). The
two-tailed probability is calculated using the Fisher’s
Exact Test.

ARexx Commands are not supported.

1.32 The Goodness of Fit Test Window

This window is opened by selecting the

The Goodness of Fit Test Menu Option
.

This window contains a large display area in which the
pairs of values (’observed’ and ’expected’) entered may be
viewed. To the right of the display box is a scroll bar
which enables rapid navigation of large sets of values.
Beneath this area are two text entry boxes in which the
new data may be entered.
Activate the left hand text entry box first by clicking
the left mouse button once while the pointer is over it,
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to enter an ’observed’ value. Hitting the return key will
automatically move between the ’observed’ and ’expected’
entry boxes, and will accept the new data pair when it has
been entered.
The box on the right hand side of the window displays the
Chi-squared value, probability and degrees of freedom.

ARexx Commands are not supported.

1.33 The About Multiplot Window

This window is opened by selecting
The About Multiplot Menu Option
.

It contains the name and address of the author and
information about registering Multiplot.

ARexx Commands are not supported.

1.34 The About StatPack Window

This window is opened by selecting
The About StatPack Menu Option
.

It displays information about the authors of StatPack and
other statistical functions they can provide.

ARexx Commands are not supported.

1.35 The Pull Window

This window is opened by using the ’PULL’ ARexx command. It
returns to the ARexx environment any text variable entered
by the user. It may be used to obtain information or values
form the user from an ARexx script.

ARexx Commands are not supported.

1.36 The Ask Window

This window may be opened by Multiplot in response to a user
selection or may be called from an ARexx script or macro.
It is used to obtain a simple Affirmative/Negative response
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from the user.

Global
and

Ask Window ARexx Commands
are supported.

1.37 The Message Window

This window may be opened by Multiplot in response to a user
selection or may be called from an ARexx script or macro.
It is used to inform the user of an error, to warn of a
change in status or to communicate some other message.

Global
and

Message Window ARexx Commands
are supported.

1.38 Menus Available in Multiplot

Pull-down menus are available from the
The Plot Window
and

control many of the functions available within Multiplot.
Menu selections are available under the following major
categories:

The Project Menu

The Edit Menu

The Actions Menu

The Options Menu

The Functions Menu

The Statistics Menu
Many of the pull down menu options also have

Keyboard Shortcuts

1.39 The Project Menu
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The Project Menu contains menu selection which are
concerned with opening and closing files and windows,
saving data and graphs and loading and saving default
settings. The options available are:

The Open File Menu Option

The Add File Menu Option

The New Graph Menu Option

The Swap Graph Menu Option

The Exit Graph Menu Option

The Save Menu Option

The Save As Menu Option

The Defaults Menu Option

The Print Preview Menu Option

The Print Setup Menu Option

The Print Menu Option

The About Multiplot Menu Option

The About StatPack Menu Option

The Quit Menu Option

1.40 The Open File Menu Option

Returns you to
The Data Selection Window
for loading

a new file, erasing all open graphs.

Keyboard Shortcut:
(Right-Amiga O)

1.41 The Add File Menu Option

Opens the
The Data Selection Window
for loading a new data
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file. All data sets and text described in that file will be
added to the current graph.

Keyboard Shortcut:
(Right-Amiga A)

1.42 The New Graph Menu Option

Opens
The Data Selection Window
for loading a new data

file, which will be loaded onto a fresh graph in a new
window.

Keyboard Shortcut:
(Right-Amiga N)

1.43 The Swap Graph Menu Option

Brings the indicated
Plot Window
to the front and sizes it

to fill the screen.

No keyboard shortcut.

1.44 The Exit Graph Menu Option

Closes the current graph without quitting the program. If
there are no other graphs open, it will open the

The Data Selection Window
to select a new graph.

Keyboard Shortcut:
(Right-Amiga E)

1.45 The Save Menu Option

Saves data, formatting and text as a Multiplot file format 2
(FF2) file, overwriting original data file.
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Keyboard Shortcut:
(Right-Amiga S)

1.46 The Save As Menu Option

Saves plots in any of the following formats: IFF (loads into
DPaint), Draw (loads into Draw2000 etc), IntroCAD (an
excellent CAD program), mCAD (a PD CAD program), HPGL
plotter language, Encapsulated Postscript and Postscript.

No keyboard shortcut.

1.47 The Defaults Menu Option

Saves and loads current axes, tics and grid markings, pen
thickness, font and palette selections. The default file
used is MPlot_support/MPlot.def unless defined as another
file with the SETTINGS start-up option or loaded by
selecting

The Defaults Menu Option
Load.

Load:
Loads a new default file and reformats the currently
active plot with the new settings.

No keyboard shortcut.

Save:
Saves default file with current name.

No keyboard shortcut.

Save As:
Opens a file requester to save the default file under a
new name.

No keyboard shortcut.

1.48 The Print Preview Menu Option

Print preview is achieved via the transparent use of the

PLT: Device
The PLT-handler must be in your l: directory,

and the PLT: mountlist must be added to your
Devs:mountlist. You do not need to mount the device as
Multiplot will mount PLT: automatically if it is not already
mounted.
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No keyboard shortcut.

1.49 The Print Setup Menu Option

Opens
The Print Setup Window
which allows the selection of

print orientation, size and position of the graph on the
page as well as selecting between colour and black and white
printing. The print spooler can be toggled on or off from
this window.

No keyboard shortcut.

1.50 The Print Menu Option

Printing is achieved via the transparent use of the

PLT: Device
.

Keyboard Shortcut:
(Right-Amiga P)

1.51 The About Multiplot Menu Option

Opens
The About Multiplot Window
displaying information

about the author and registration of Multiplot XLN and
Multiplot XLN-S.

No keyboard shortcut.

1.52 The About StatPack Menu Option

Opens
The About StatPack Window
displaying information

about the authors of StatPack and other statistical
functions they can provide.

No keyboard shortcut.
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1.53 The Quit Menu Option

Exits the program without saving any changes.

Keyboard Shortcut:
(Right-Amiga Q)

1.54 The Edit Menu

The Edit menu contains options to cutting, pasting adding
or deleting data sets, points, axes or text from a graph.
The options available are:

The Undelete Menu Option

The Cut Menu Option

The Copy Menu Option

The Paste Menu Option

The Delete Menu Option

The View Data Menu Option

The Add Menu Option

1.55 The Undelete Menu Option

Replaces the last blocks of text or data sets deleted. Only
a single level of undelete is maintained, but it may
contain multiple items if, for example, several data sets
were group selected and deleted.

Keyboard Shortcut:
(Right-Amiga Z)

1.56 The CUT Menu Option

Deletes the selected data sets or text blocks and places an
IFF FTXT text copy of in the clip board for transfer to
another plot or program, and then deletes it from the
current plot.
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Keyboard Shortcut:
(Right-Amiga X)

1.57 The Copy Menu Option

Places an IFF FTXT text copy of the selected data sets or
text blocks in the clip board for transfer to another plot
or program.

Keyboard Shortcut:
(Right-Amiga C)

1.58 The Paste Menu Option

Reads the clipboard and adds its contents to the current
graph if possible.

Keyboard Shortcut:
(Right-Amiga V)

1.59 The Delete Menu Option

Removes currently selected point(s), data set(s) or
block(s) of text.

Keyboard Shortcut:
(Delete key)

1.60 The View Data Menu Option

Opens The Data Entry Window displaying the selected
data set.

No keyboard shortcut.
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1.61 The Add Menu Option

Text
Opens

The Edit Text Window
to edit the prose, font

and font size of text which is added to the current plot and
may be moved to the desired location. If the option is
chosen while a data set is selected, it will add a legend to
the data set.

Data Set
Adds a data set to the end of the current open plot.
Opens

The Custom Plot Window
to set the type and colour

of the data set, and then opens The Data Entry Window to
enter the data values. After the last data point has been
entered, entry is terminated by selecting the CONTINUE
button which results in the new data set being plotted, or
abandoned, by selecting the STOP button.

Point
Adds a point to the end of the currently selected
data set. Opens

The Edit Point Window
to edit the point

values.

Axis
Adds a new Y Axis above the last Y Axis rendered. The
axis may then be moved to the right side or changed by
calling up

The Edit Axis Window
by double clicking to the

left of the new axis.

No keyboard shortcut.

1.62 The Actions Menu

The Actions Menu contains options which perform particular
changes to the current graph. The options available are:

The Mouse Action Menu Option

The Redraw Menu Option

The Update Menu Option

The Full Plot Option
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The Redefine Plot Menu Option

The Align Vertical Menu Option

The Align Horizontal Menu Option

1.63 The Mouse Action Menu

Allows the user to select the mode in which the mouse works.
The options are:

Select
The select mode allows the editing of data sets or axes by
double clicking the left mouse button over them and allows
the movement of points and text by click-dragging, and
selection of text or data sets for manipulation.

Keyboard Shortcut:
(Right-Amiga-Shift !)

Zoom
Allows close-up views of areas of the data, and to adjust
the axes to desired values. After selecting ZOOM from the
menu, the mouse may be used to draw a box on the screen to
indicate the area of the plot to be enlarged. This is
achieved by clicking and holding the left mouse button,
dragging the mouse, and releasing the left mouse button.
The maximum limit of enlargement is 1,600 times. Zooming
out to reduce the size of the plot by one half is achieved
by double clicking the left mouse button.

Keyboard Shortcut:
(Right-Amiga-Shift #)

Slide
After selection the mouse may be used to draw a vector on
the screen to indicate the direction and amount the plot
should be moved. This is achieved by clicking and holding
the left mouse button, dragging the mouse, and releasing
the left mouse button.

Keyboard Shortcut:
(Right-Amiga-Shift ^)

1.64 The Redraw Menu

Redraws the currently active
Plot Window
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. It should be used
to repair the screen of unwanted rendering, or an incomplete
refresh.

Keyboard Shortcut:
(Right-Amiga R)

1.65 The Update Menu

Redraws the currently active
Plot Window
recalculating all

text positions and correcting minor displacements resulting
from resizing

The Plot Window
.

Keyboard Shortcut:
(Right-Amiga U)

1.66 The Full Plot Menu

Redraws the currently active
Plot Window
at the default

scale. This plot will show all data points and the extremes
of any error bars unless the X or Y scales are locked.

Keyboard Shortcut:
(Right-Amiga F)

1.67 The Redefine Plot Menu

Presents the user with
The Custom Plot Window
for each

data set in succession.

Keyboard Shortcut:
(Right-Amiga D)
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1.68 The Align Vertical Menu

Aligns the selected points and text by their:
Left Edges
Centres
Right Edges

No keyboard shortcut.

1.69 The Align Horizontal Menu

Aligns selected points and text by their:
Tops
Centres
Bottoms

No keyboard shortcut.

1.70 The Options Menu

The Options Menu contains selections which affect the
current state of the running of Multiplot. The options
available are:

The Graph Type Menu Option

The Cross Hair Menu Option

The Coordinates Menu Option

The Axes Menu Option

The Right Margin Menu Option

The Palette Menu Option

The Significant Figures Menu Option

The Error Bars Menu Option

The Axis Scale Lock Menu Option

The Axis Values Lock Menu Option

1.71 The Graph Type Menu Option
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Selects what plot mode is used for the currently active
graph. Options are:

Plot
Renders data points on X/Y axes.

Scatter
Plots Y values in a vertical scattergram. Automatically
separates overlying points laterally. Selecting this plot
mode enables the menu options for statistics describing or
comparing the Y values of data sets.

Box Plot
Produces box plots of Y values. Selecting this plot mode
enables the menu options for statistics describing or
comparing the Y values of data sets.

No keyboard shortcuts.

1.72 The Cross Hair Menu Option

Provides a cross hair for the cursor to assist with zooming,
sliding and movement of points and text blocks.

Keyboard Shortcut:
(Right-Amiga L)

1.73 The Coordinates Menu Option

Opens the COORDINATES WINDOW providing the pixel location
of the pointer over the currently active

Plot Window
.

No keyboard shortcut.

1.74 The Axes Menu Option

Allows the selection of a box frame, X and Y axes or no axes
marked.

X and Y
Keyboard Shortcut:
(Right-Amiga Y)
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Box
Keyboard Shortcut:
(Right-Amiga B)

None No keyboard shortcut.

1.75 The Right Margin Menu Option

Toggles the right margin space for legends.

Keyboard Shortcut:
(Right-Amiga M)

1.76 The Palette Menu Option

The screen palette may be altered by calling this requester.
The only non obvious feature of the requester is that by
clicking the left mouse button on the RGB characters, the
requester is converted to a hue/saturation/lightness
requester for those who think that way.

No keyboard shortcut.

1.77 The Significant Figures Menu Option

Allows the number of significant figures of axis values and
formulae to be set independently. This option only applies
to values calculated subsequent to its selection. To change
values already on screen, it is necessary to force a
recalculation. For axis values this can be achieved by
selecting

The Full Plot Option
or

The Redefine Plot Menu Option
.

To alter legends of line fits, the line fit needs to be
deleted and recalculated.

No keyboard shortcut.
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1.78 The Error Bars Menu Option

Toggles the X and Y error bars on and off. If a data set is
loaded without error bars, and error data is added later via

The Edit Point Window
, it will be necessary to select this

option to get them rendered. If error bars are unimportant,
this option should be turned off to speed screen refresh
times. This option is set and saved as part of the plot
defaults file and the new Multiplot File Format 2 data file
format.

No keyboard shortcut.

1.79 The Axis Scale Locks Menu

Allows either the X or Y dimension to be frozen while the
other is zoomed or rescaled and allows arrangement of the
scale of the plot to best advantage. The sub item "X Region"
will lock the amount of zoom in the X axis. The lock may be
turned off by reselecting the sub item. The same applies for
the "Y Region" selection. The "Both Locks On" selection will
lock both axes. They can be both turned off with "Both Locks
Off". Unless locked, the following options will reset the
view of your data: Full Plot, Linear Fit, Smooth and
Logarithmic Fit.

1.80 The Axis Values Lock Menu

Allows either the X or Y axis values to remain unchanged
despite rescaling of the axis. This option allows the
editing of axis values to create text labels without having
them moved or overwritten.

1.81 The Functions Menu

The Functions Menu contains options which perform specific
transformations to data - smoothing, line fits etc, or
allow access to ARexx scripting and macro commands which
can be used to transform data. The options available are:

The Sort Data Menu Option

The Smooth Data Menu Option

The Linear Fit Menu Option
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The Polynomial Fit Menu Option

The ARexx Macro Menu Option

1.82 The Sort Data Menu Option

This option will place the data points in order of
ascending X value. This allows other manipulations of the
data which require this format.

No keyboard shortcut.

1.83 The Smooth data Menu Option

Select a data set by clicking the left mouse button near
one of its points, and then select one of the subitems from
this menu option.

Filter
A new data set will be created in which each Y
value is set to the mean of the surrounding Y values from
the original data set. A requester will appear enabling you
to enter the number of values each side of the point for
the mean to be taken over. This option is most suitable for
smoothing data sets containing large numbers of points.

No keyboard shortcut.

Interpolate
A new data set will be created in which
intermediate data points are added to create a smooth curve
tracking the original data. This option is most suitable for
smoothing data sets with relatively few points. It is
sometimes useful to provide intermediate points before
filtering to provide a smoother curve.

No keyboard shortcut.

1.84 The Linear Fit Menu Option

A new data set will be created which will represent a
straight line fit of the selected data set. The formula
of the line is shown in the legend. The current axis
settings are taken into account for linear fits of data.
For example, if the Y axis is logarithmic and the X axis
linear, an exponential fit is produced (a straight line
on a lin/log scale). If the X axis is logarithmic and the
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Y axis linear, a log fit is produced (a straight line on a
log/lin scale). Similarly, log/log and true linear fits are
also available.

No keyboard shortcut.

1.85 The Polynomial Fit Menu Option

Creates a new data set displaying a polynomial fit of the
selected data set. A window allows selection of the order of
fit. High order fits may require extended calculation times.
A new data set will be created which will represent the fit
of the data. The formula of the line will be displayed as
its legend if there is sufficient room.

No keyboard shortcut.

1.86 The ARexx Macro Menu Option

Opens the file requester to select an ARexx macro for
execution.

Keyboard Shortcut:
(Right-Amiga G)

1.87 The Statistics Menu

The Statistics Menu provides statistical functions which
allow the description or comparison of values as well as
the Fisher’s exact test, contingency table analysis
and the Chi-squared Goodness of Fit test. The options
available are:

The Description Menu Option

The Percentiles Menu Option

The One Sample t Test Menu Option

The Two Sample t Test Menu Option

The Mann-Whitney U Test Menu Option

The Contingency Table Menu Option

The Fisher’s Exact Test Menu Option
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The Goodness of Fit Test Menu Option

1.88 The Description Menu Option

This menu option may be chosen after selecting a data set
while the

Graph Type
is either

Scattergram or Box Plot.

It will open
The Description Window
.

No keyboard shortcut.

1.89 The Percentiles Menu Option

This menu option may be chosen after selecting a data set
while the

Graph Type
is either

Scattergram or Box Plot.

It will open
The Percentiles Window
.

No keyboard shortcut.

1.90 The One Sample t Test Menu Option

This menu option may be chosen after selecting a data set
while the

Graph Type
is either

Scattergram or Box Plot.

It will open
The One Sample t Test Window
.

No keyboard shortcut.
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1.91 The Two Sample t Test Menu Option

This menu option may be chosen after selecting two data
sets while the

Graph Type
is either Scattergram

or Box Plot. Select the two data sets by selecting the
first one (single click of the left mouse button while the
pointer is over a data point from the data set), and then
holding down the shift key while selecting the second set.

It will open
The Two Sample t Test Window
.

No keyboard shortcut.

1.92 The Mann-Whitney U Test Menu Option

This menu option may be chosen after selecting two data
sets while the

Graph Type
is either Scattergram

or Box Plot. Select the two data sets by selecting the
first one (single click of the left mouse button while the
pointer is over a data point from the data set), and then
holding down the shift key while selecting the second set.

It will open
The Mann-Whitney U Test Window
.

No keyboard shortcut.

1.93 The Contingency Table Menu Option

This menu option will open
The Contingency Table Window
.

No keyboard shortcut.

1.94 The Fisher’s Exact Test Menu Option
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This menu option will open
The Fisher’s Exact Test Window
.

No keyboard shortcut.

1.95 The Goodness of Fit Test Menu Option

This menu option will open
The Goodness of Fit Test Window
.

No keyboard shortcut.

1.96 Menu Command Keyboard Shortcuts

Multiplot fully supports keyboard shortcuts using the right
Amiga key. A full list of shortcuts and mnemonics is listed
below:

Key Command Mnemonic

A
PROJECT/Add file <A>dd File

B
OPTIONS/Axes/Box <B>ox

C
EDIT/Copy <C>opy

D
ACTIONS/ReDefine Plot Re<D>efine Plot

E
PROJECT/Exit Graph <E>xit Graph

F
ACTIONS/Full Plot <F>ull Plot

G
FUNCTIONS/ARexx Macro <G>o ARexx

H
PROJECT/Save as/HPGL <H>PGL
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I
PROJECT/Save as/ILBM <I>LBM

J not used

K
PROJECT/Save as/DrawSave <K>AD format

L
OPTIONS/Cross Hair Hair <L>ines

M
OPTIONS/Right Margin <M>argin

N
PROJECT/New Graph <N>ew Graph

O
PROJECT/Open File <O>pen

P
PROJECT/Print <P>rint

Q
PROJECT/Quit <Q>uit

R
ACTIONS/Redraw <R>edraw

S
PROJECT/Save <S>ave

T
PROJECT/SaveAs/IntroCAD In<T>roCAD

U
ACTIONS/Update <U>pdate

V
EDIT/Paste Commodore guidelines

W
PROJECT/Save as/Data <W>rite data

X
EDIT/Cut Commodore guidelines

Y
OPTIONS/Axes/X and Y X and <Y>

Z
EDIT/Undelete Commodore guidelines

Please note that there are three other keyboard shortcuts
that allow you to swap between mouse actions. These also
require that the right Amiga key is held down.

Shift-
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1
(!) ACTION/Mouse Action/Select

Shift-
3
(#) ACTION/Mouse Action/Zoom

Shift-
6
(^) ACTION/Mouse Action/Slide

The Escape and Delete keys are supported:

Esc
PROJECT/Quit

Del
EDIT/Delete

The Alt key is used to activate the curve reader. Holding
down the Alt key while clicking the left mouse button while
in SELECT mode will result in a window that displays the
X and Y co-ordinates of the pointer.

The Shift key activates group selection when in
SELECT mode.

The Ctrl key allows selection of a single data point
instead of a whole data set when in SELECT mode.

The ’v’ key restricts movement of selected items to
vertical.

The ’h’ key restricts movement of selected items to
horizontal.

1.97 Using The PLT: Device

1) The PLT-handler must be in your l: directory, and the
mountlist entry for PLT: added to the devs:mountlist
(WB2.0) or The device driver to be placed in the
storage/dosdrivers directory (WB2.1).

2) A printer MUST be chosen within the Printer
Preferences program. Failure to do this courts certain
disaster!

3) You do not need to mount the device. Multiplot will
mount PLT: automatically if it is not already mounted.

4) PLT: opens its own window on the WorkBench when it
starts up. This window relays information about how much of
the image has been printed and the remaining system memory.
It also provides a "close gadget" (The square with a dot in
it for closing windows) which will abort the print. Use the
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left-Amiga-M and left-Amiga-N key combinations to switch
between Multiplot’s screen and the WorkBench or else run
Multiplot on the WorkBench screen using the
PUBSCREEN=Workbench start-up option.

5) Multiplot checks for the presence of the PLT-handler in
the L: directory before attempting to mount PLT:. If this
file is not present, Multiplot will not print, even if the
PLT: device has been mounted by some other mechanism.

6) The PLT: device checks the print resolution requested in
preferences. If you want the nicest possible quality
print-outs from Multiplot, set your printer density setting
to "7".

7) PLT: currently has a bug which prevents it from handling
two tasks simultaneously. Do not attempt to print preview
while printing or print two files at once.

8) PLT: is unable to be used while the printer is engaged in
any task.

1.98 Multiplot’s ARexx Interface

The best way of learning any programming language is by
example. The ARexx Macro Examples disk includes all the
examples below as well as a collection of useful macros
for manipulating data and performing simple statistical
analysis.

STARTING OUT
Multiplot will automatically open an ARexx port on start-up
providing it can open the rexxsyslib.library library and
ARexx is running. The port will be named MULTIPLOT.nn unless
defined otherwise using PORTNAME start-up options. This port
may be used as a user interface to control all of
Multiplot’s functions.

An ARexx macro interacting with Multiplot must contain a
comment line at the start. It must then set the command
address to Multiplot’s port. Then any lines following will
be sent to Multiplot for interpretation.

Example 1
Multiplot has ARexx "modes" which are the equivalents of the

currently open windows or requesters. You can ask Multiplot
which window is currently receiving ARexx commands by
sending a ’QUERY’ command. Multiplot will then return a
string stating its current mode. Commands that result in a
message requester do not generate an ARexx message. The
requester will, however, answer a ’QUERY’ and reply with the
error message. System requesters (such as the "Insert disk
X:" requester) do not support ARexx and must be either
disabled or dealt with individually.
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Each mode supports a subset of commands and if a
command is received that is not supported, Multiplot will
return an error code. Neither The About Window nor

The Introduction Window
uses the ARexx port. As they both

require input by mouse or keyboard to clear, neither window
should be opened from an ARexx script. To avoid

The Introduction Window
, use the QUIET start-up option.

The About Window cannot be opened by ARexx command and
does not require any special handling to avoid.

The ARexx commands available from within Multiplot are:

Global ARexx Commands

The Ask Window ARexx Commands

The Message Window ARexx Commands

The Data Selection Window ARexx Commands

The Plot Window ARexx Commands

The Custom Plot Window ARexx Commands

The Print Set-up Window ARexx Commands

The Edit Point Window ARexx Commands

The Edit Axis Window ARexx Commands

The Edit Text Window ARexx Commands

1.99 Global ARexx Commands

The following commands are available in all windows with the
few exceptions noted below.

QUERY Returns a value describing the currently active window
and often provides other useful information. The exact
format of the returned value depends on the current window
and is described for each window individually below.

ERROR N Returns text describing the error resulting in the
error code supplied where N is the error code.

ASK <text> Opens
The Ask Window
to query the user and
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returns the text of the reply, either "OKAY" or "CANCEL".
This option is not available from

The Ask Window
or

The Message Window
.

SAY <text> Opens
The Message Window
to notify the user of

<text>. This option is not available from
The Ask Window
or

The Message Window
.

PULL <text> Opens a PULL WINDOW to query the user for a
value and returns that text.

1.100 ARexx Example 1

/* This is a simple example script to get past

The Data Selection Window

*/
address MULTIPLOT.01
/* The above line tells ARexx that you want to control
Multiplot */
’FILE’
/* The above line clears the file name */
’CONTINUE’
/* The above line closes

The Data Selection Window

*/
/* End script */

1.101 The Message Window ARexx Commands

This window is used to inform the user of errors, warnings
or to pass other messages. The supported commands are:

QUERY Returns "MESREQ <message>"

CONTINUE Closes
The Message Window
, acknowledging the

message.
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STOP Closes
The Message Window
, acknowledging the message.

1.102 The Ask Window ARexx Commands

This window asks the user a question which must be answered
by either confirming or negating the question.
The supported commands are:

QUERY Returns "ASKREQ <question>"

POSTEXT Returns text describing the positive option.

NEGTEXT Returns text describing the negative option.

CONFIRM Closes
The Ask Window
, accepting positive option.

CONTINUE Closes
The Ask Window
, accepting positive option.

DENY Closes
The Ask Window
accepting negative option.

STOP Closes
The Ask Window
accepting negative option.

1.103 The Data Selection Window ARexx Commands

This window provides a way of setting the input file name
and the column numbers to be read for data within that file.
The supported commands are:

QUERY Returns "DATSEL filename"

CONTINUE Closes window, accepting current settings,
continuing on to the Plot window.

QUIT Closes window rejecting changes and quits Multiplot if
there is no open

Plot Window
.

STOP Closes window rejecting changes and quits Multiplot if
there is no open
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Plot Window
.

FILE [<filename>] If no file name is defined, clears the
file name field allowing a blank plot to be opened. If file
name is defined, loads that name into the FILE box of the
window.

REQ Opens the file requester to assist with locating a data
file for input.

COLUMN N XCOL|YCOL|ECOL|EDWN|XERR|XEDN Sets column
number for a data type. Requires 2 arguments. The first (N)
is numerical and is the column number. The second defines
the data type, and must be one of the following:

XCOL X values

YCOL Y values

ECOL Error in Y values

EDWN Low error in Y values for asymmetrical errors

XERR Error in X Values

XEDN Low error in X values for asymmetrical errors

1.104 The Plot Window ARexx Commands

These windows (multiple windows may be open at a time) are
used to render graphs. The currently active window is chosen
with the ’ACTIVATE’ command. To take the place of mouse
controlled object and group selection is the ’SELECT’
command. In order to make this command as flexible as
possible, object selection involves multiple actions.

Example 2
Both legends and individual points are regarded as being

part of a data set that must be selected first. Therefore
selecting a point involves 4 steps: 1) Select data set,
2) Select point, 3) Confirm selection, and 4) Launch
selection:

Example 3
Multiple objects can be selected by using ’SELECT ADD’

to add them to the selection list. A group selection can be
aborted by using the ’SELECT ABORT’ command or by using
’SELECT REPLACE’ to replace the current selection list with
the most recently selected object.
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Example 4
Data may be exchanged between Multiplot and the ARexx script

using the PEEK, POKE and PULL commands which work
through the Rexx Variables Interface. The PEEK command
copies data from Multiplot and places it in specially named
variables. ARexx scripts may "PEEK" at either a single
point or at all the values from a data set. The POKE
command copies data from the ARexx script and places it
within a selected point or data set. Again the data
transferred is copied from a specially named variable.
The PULL command is available from all windows and was
described above in the section on Global Commands.

Below is a full list of supported ARexx commands:

QUERY Returns "PLOWIN <filename> N" Where <filename> is
the current plot and N is the number of data sets within
that graph.

PEEK N [NOVALS|XVALS|YVALS|EVALS|EDWN|XEVALS|XEDWN]
Copies data from the Nth selected item to be stored with in
the ARexx program as a variable with the same name as the
selected option. If a point is peeked at (ie the Nth
selection is a selected point) then the option key word is
not used and the point’s values are stored in an ARexx
variable named POINTVALS as text containing six words
describing the X, Y, high error in X, low error in X, high
error in Y and low error in Y in that order. If a data set
is peeked at (ie the Nth selection is a selected data set)
then the following key words effect the response by
Multiplot:

NOVALS Stores a single word describing the number of values
in the data set in an ARexx value called "NOVALS".

XVALS Stores a text string with all the X values of the
data set in a value called "XVALS".

YVALS Stores a text string with all the Y values of the
data set in a value called "YVALS".

EVALS Stores a text string with all the high error in Y
values of the data set in a value called "EVALS".

EDWN Stores a text string with all the low error in Y
values of the data set in a value called "EDWN".

XEVALS Stores a text string with all the high error in X
values of the data set in a value called "XEVALS".

XEDWN Stores a text string with all the low error in X
values of the data set in a value called "XEDWN".

POKE N
[NOVALS|XVALS|YVALS|EVALS|EDWN|XEVALS|XEDWN] Copies
data to the Nth selected item from an ARexx program variable
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with the same name as the selected option. If a point is
poked at (ie the Nth selection is a selected point) then the
option key word is not used and the point’s values are read
from an ARexx variable named POINTVALS as text containing
six words describing the X, Y, high error in X, low error in
X, high error in Y and low error in Y in that order. If a
data set is poked at (ie the Nth selection is a selected
data set) then the following key words effect the response
by Multiplot:

NOVALS Ensures that the selected data set has NOVALS
number of values in it ready to receive that number of data
points on a subsequent POKE command where NOVALS is the
name of a variable set within the ARexx script. If a data set
has too few values, it will be enlarged to hold NOVALS number
of points.

XVALS Reads a text string stored in an ARexx variable
called "XVALS" and copies the values to the selected data
set’s X values.

YVALS Reads a text string stored in an ARexx variable
called "YVALS" and copies the values to the selected data
set’s Y values.

EVALS Reads a text string stored in an ARexx variable
called "EVALS" and copies the values to the selected data
set’s high error in Y values.

EDWN Reads a text string stored in an ARexx variable
called "EDWN" and copies the values to the selected data
set’s low error in Y values.

XEVALS Reads a text string stored in an ARexx variable
called "XEVALS" and copies the values to the selected data
set’s high error in X values.

XEDWN Reads a text string stored in an ARexx variable
called "XEDWN" and copies the values to the selected data
set’s low error in X values.

OPEN Closes all open plots and provides

The Data Selection Window
to select a new data file.

ADDFILE Opens
The Data Selection Window
, to add data file

selected to the currently active
Plot Window
.
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NEWGRAPH Opens
The Data Selection Window
, to load data file

selected into a new
Plot Window
.

ACTIVATE N Activates (selects) the Nth
Plot Window
.

CLOSEGRAPH Closes currently activated
Plot Window
.

SAVE Saves data file with current file name.

HPGLSAVE <filename> Saves all open plots as an HPGL file.

MCADSAVE <filename> Saves currently active
Plot Window
as a

MCAD file.

ILBMSAVE <filename> Saves screen as an IFF ILBM file.

DRAWSAVE <filename> Saves all open plots as a DRAW file.

PSCRSAVE <filename> Saves all open plots as a Postscript
file.

EPSFSAVE <filename> Saves all open plots as an encapsulated
Postscript file.

ICADSAVE <filename> Saves currently active
Plot Window
as an

IntroCAD file.

DATSAVE <filename> Saves currently active
Plot Window
as a

Multiplot data file.

SADEF Saves default settings.

PREVIEW Provides print preview.

PROPT Allows setting print options via the
The Print Set-up Window
.

PRINT Prints all open graphs.

QUIT Closes all
Plot Windows
and quits Multiplot.
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SELECT ABORT|REPLACE|ADD|(SET N)|(TEXT [N])|(POINT N)
Selects the indicated object. Is the ARexx equivalent of
"single clicking" the left mouse button in the indicated
object. Note above explanation of the use of SELECT and its
options. The supported modifiers are:

ABORT Cancels selection in process

REPLACE Accepts selection, replacing previously
selected objects

ADD Accepts selection, adding it to previously
selected objects

SET N Selects the Nth data set.

TEXT [N] If data set selected but not confirmed,
this option modifies selection to indicate the legend of the
selected data set. If no data set is selected, it selects
the Nth additional text in the currently activated

Plot Window
.

POINT N Used to modify selection of a data set to
indicate the Nth point of that set.

UNSELECT Dumps list of selected objects.

LAUNCH Launches selected objects. Is the ARexx equivalent of
"double clicking" the left mouse button.

UNDELETE Replaces any deleted selections.

CUT Copies currently selected objects to clip board then
deletes them from currently activated

Plot Window
.

COPY Copies currently selected objects to clip board.

PASTE Pastes clipboard contents to currently activated

Plot Window
.

DELETE Deletes currently selected objects.

TEXTADD <String> Adds string as an additional text label.

SETADD Opens
The Custom Plot Window
and subsequent

Edit Point Windows
to permit addition of a new data set to
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the currently active
Plot Window
.

POINTADD Opens
The Edit Point Window
to define an

additional point which is added to the currently selected
(and confirmed) data set.

AXISADD Adds a new Y Axis.

EDAXIS YAXIS|XAXIS [N] Opens
The Edit Axis Window
to open

the indicated axis. If the YAXIS modifier is used, the
optional numerical modifier indicates that the Nth Y axis
is to be edited.

EDTITLE Opens
The Edit Text Window
to modify the title text.

FULLPLOT Resets axis dimensions and replots current graph to
fit within new axes.

REDRAW Refreshes graph rendering.

REPLOT Recalculates text positions and scaling, then redraws
graph.

DEFINEPLOT Sequentially opens an Custom Plot window for
each data set in current graph.

COORDWINDOW Opens the Coordinate window which displays
current pixel locations of the mouse pointer.

FUNCTION SORT|FILTER|INTERP|SLINE|POLY N Performs one
of the following functions on the currently selected data
set.

SORT Sorts the points into ascending X values.

FILTER Smooths data set by a rolling mean method
producing a new data set displaying the result.

INTERP Smooths data set by an open B-spline interpolation
method producing a new data set displaying the result.

SPLINE Calculates a best straight line fit of data
by the least squares method producing a new data set
displaying the result.

POLY N Calculates a polynomial to the Nth order (where N
must be an integer from 1 to 5) best fit of data using a
Gauss- Seidel iterative technique producing a new data set
displaying the result.
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SFIGS VAL|FORM Sets the number of significant figures used
in calculating the following:

VAL Axis tic values.

FORM Values used in formulae produced from
functions.

YERRBARS ON|OFF Sets the display of Y error bars (if data is
present) to:

ON; or

OFF.

XERRBARS ON|OFF Sets the display of Y error bars (if data is
present) to:

ON; or

OFF.

RMARGIN ON|OFF Switches display of the right margin in
which data set legends may be displayed to:

ON; or

OFF.

XHAIR ON|OFF Switches between normal mouse pointer and
cross- hair cursor.

ON Displays cross-hair.

OFF Displays mouse pointer.

ALIGN (VERTICAL LEFT|CENTRE|RIGHT)|(HORIZONTAL
TOP|CENTRE|BOTTOM) Aligns selected items either vertically
or horizontally.

VERTICAL Aligns selected items vertically
LEFT By their left edges.
CENTRE By their centres.
RIGHT By their right edges.

HORIZONTAL Aligns selected items horizontally
TOP By their tops.
CENTRE By their centres.
BOTTOM By their bottoms.

FORMAT XANDY|BOX|NONE Sets the format of the axes. The
possible selections are:

XANDY Stem and leaf (X and Y) axes.

BOX Box axes.
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NONE No axes.

Example 5

1.105 rexxexample2

Example 2:
To select and edit a data set requires 3 steps: 1) Select
data set, 2) Confirm selection and 3) Launch selection:

/* This is a simple example script to open

The Custom Plot Window
for the first data set in a graph

once on screen */

address MULTIPLOT.01
’SELECT SET 1’
’SELECT ADD’
’LAUNCH’
/* End script */

1.106 rexxexample3

/* This is a simple example script to open

The Edit Point Window
for the fifth point

in the first data set in a graph */
address MULTIPLOT.01
’SELECT SET 1’
’SELECT POINT 5’
’SELECT ADD’
’LAUNCH’
/* End script */

1.107 rexxexample4

The following is an example in which the legend, and first
two points are deleted from a currently displayed data set:

/* This is a simple example script to delete the legend and
first two points first data set in a graph */
address MULTIPLOT.01
/* simple so far */
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’SELECT SET 1’
’SELECT TEXT’
’SELECT ADD’
/* The above 3 lines selects the legend from the first data
set */
’SELECT SET 1’
’SELECT POINT 1’
’SELECT ADD’
/* The above 3 lines selects the first point from the first
data set and adds it to the existing selection */
’SELECT SET 1’
’SELECT POINT 2’
’SELECT ADD’
/* The above 3 lines select the second point from the first
data set and adds it to the previous selection */
’CUT’’
/* The above line cuts the selection to clipboard */
/* End script */

1.108 rexxexample5

/* Hi Let’s try this one */
address MULTIPLOT.01
’FILE DATA/PLOTME.DAT’
/* The above line sets the input file */
’COL 1 XCOL’
’COL 2 YCOL’
’COL 3 ECOL’
’COL 4 EDWN’
’COL 3 XERR’
’COL 4 XERR’
/* The above 6 lines set the data columns for the input
file */
’CONTINUE’
/* The above line closes

The Data Selection Window

*/
’YERR OFF’
’XERR OFF’
/* The above 2 lines turn off the rendering of error bars */
’FULLPLOT’
/*The above line replots the graph at the largest size that
just fits within the axes. */
/* end script */

1.109 The Custom Plot Window ARexx Commands

This window allows the user to choose how each data set is
represented: the colour, line type, point type and size,
which Y axis it is rendered on and the type of plot (points,
line, both, bar, impulse, step).
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The supported ARexx commands are:

QUERY Returns "CUSTPLOT Set number N" Where N is the set
number.

POINT N [SQUARE|PLUS|STAR|TIMES|DIAMOND|TRIANGLE]
Sets point size to N and the point shape to one of:

SQUARE

PLUS

STAR

TIMES

DIAMOND

TRIANGLE

LINETYPE N Sets line type to line pattern number N.

COLOUR N Sets colour of data set to colour number N.

YAXIS N Sets the data set to be plotted in the Nth Y Axis.

PLOT POINT|LINE|BOTH|STEP|IMPULSE|BAR Sets the data set
to be plotted as one of the following:

POINT A series of points in the current colour, point type
and size.

LINE A line rendered in current colour and line type.

BOTH A series of points in the current colour, point type
and size joined by a line rendered in current colour and
line type.

STEP A stepped line rendered in current colour and line
type.

IMPULSE A series of lines rendered in current colour and
line type that extend from points rendered in the current
colour, point type and size to the X Axis.

BAR A series of bars rendered in current colour and line
type that extend to the X Axis.

CONTINUE Accepts current changes, closes the custom plot
window and replots the graph.

STOP Cancels any changes, closes the custom plot window and
replots the graph.

SKIP Closes the custom plot window and replots the graph
without rendering the currently selected data set.
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KILL Closes the custom plot window and replots the graph
after deleting the currently selected data set.

Example 6

1.110 Example 6

/* This ARexx script formats Plotme.dat into two stacked Y
axes and selects points and line types for the data sets. */

address MULTIPLOT.01
’FILE DATA/PLOTME.DAT’
’COL 1 XCOL’
’COL 2 YCOL’
’CONTINUE’
/* The above 4 lines set the filename and data columns, then
load data */
’AXISADD’
/* The above line adds a second Y axis stacked above the
first */
’SELECT SET 1’
’SELECT ADD’
’LAUNCH’
/* The above 3 lines open

The Custom Plot Window
to edit

the first data set */
’PLOT POINT’
’POINT 12 STAR’
’YAXIS 2’
’COLOUR 1’
’CONTINUE’
/* The above 5 lines set the data set to be plotted in
colour 1 as 12 pixel high points shaped like stars in the
second (upper) Y Axis */
’SELECT SET 3’
’SELECT ADD’
’LAUNCH’
/* The above 3 lines open

The Custom Plot Window
to edit

the third data set */
’PLOT LINE’
’LINETYPE 1’
’YAXIS 2’
’COLOUR 1’
’CONTINUE’
/* The above 5 lines set the data set to be plotted in
colour 1 solid lines in the second (upper) Y Axis */
’SELECT SET 2’
’SELECT ADD’
’LAUNCH’
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’PLOT POINT’
’POINT 12 TRIANGLE’
’YAXIS 1’
’COLOUR 2’
’CONTINUE’
/*****/
’SELECT SET 4’
’SELECT ADD’
’LAUNCH’
’PLOT LINE’
’LINETYPE 2’
’YAXIS 1’
’COLOUR 2’
’CONTINUE’
/*****/
’FULLPLOT’
/* end script */

1.111 The Edit Axis Window ARexx Commands

This window allows the user to set the minimum and maximum
values, the tic numbers, types, colours, line patterns, as
well as the axis text label, type, and position.
The supported ARexx commands are:

QUERY Returns "EDAXIS ? Axis N" Where ? is either X or Y,
and N is an integer indicating the Y axis number.

LABEL Opens
The Edit Text Window
to add or change the axis

label.

GRID BIG|SMALL [N1 [N2 [N3]]] Sets characteristics of the
grid or tics on the axis. The following arguments may be
used:

BIG Switch keyword indicating that the big tics will be
affected by changes.

SMALL Switch keyword indicating that the small tics will
be affected by changes.

N1 An integer indicating the new number of
subdivisions.

N2 An integer indicating the sort of subdivision
marking. If is ’0’, indicates that tic marks should be
used. Otherwise a value from 1 - 6 indicates line type for
grid lines.

N3 An integer indicating the number of the colour for the
grid or tics to be rendered in.
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SCALE MIN|MAX N Sets the minimum or maximum axis values
where:

MIN Is a switch keyword which sets the minimum axis
value.

MAX Is a switch keyword which sets the maximum axis
value.

N is a decimal value.

TYPE LIN|LOG|CAT Sets the axis type to one of the following:

LIN Linear

LOG Logarithmic

CAT Category

POSITION RIGHT|LEFT Sets the position of the Y axis to
either the right or the left.

RIGHT Sets position to the right of the plot.

LEFT Sets the position to the left of the plot.

LOCKS SCALE|VALUES ON|OFF Sets the axis locks on or off.

SCALE Switch keyword indicating the axis scale lock.

VALUES Switch keyword indicating the axis values lock.

ON Turns lock on.

OFF Turns lock off.

CONTINUE Closes
The Edit Axis Window
, accepting current

changes.

STOP Closes
The Edit Axis Window
, discarding current

changes.

KILL Deletes current Y axis if more than one Y axis present.

1.112 The Edit Point Window ARexx Commands

This window allows the user to set the values of an
individual point. Supported ARexx commands are:

QUERY Returns the string "POINTED Point number N1 of set
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number N2" where the point is the N1st point of the N2nd
data set.

SET N XVAL|YVAL|EVAL|EDWN|XERR|XEDN Sets a point value
to N where N is a decimal number.

XVAL Sets X value.

YVAL Sets Y value.

EVAL Sets high error in Y value.

EDWN Sets low error in Y value.

XERR Sets high error in X value.

XEDN Sets low error in X value.

CONTINUE Closes
The Edit Point Window
, accepting current

changes.

STOP Closes
The Edit Point Window
, discarding current

changes.

1.113 The Data Entry Window ARexx Commands

This window allows the user to set the values of the
points within a data set. Supported ARexx commands are:

QUERY Returns the string "DE"

SET N XVAL|YVAL|EVAL|EDWN|XERR|XEDN Sets a point value
to N where N is a decimal number.

XVAL Sets X value.

YVAL Sets Y value.

EVAL Sets high error in Y value.

EDWN Sets low error in Y value.

XERR Sets high error in X value.

XEDN Sets low error in X value.

NEXT Moves the cursor from the point currently being edited
to the next point.

PREVIOUS Moves the cursor from the point currently being
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edited to the previous point.

CONTINUE Closes
The Data Entry Window
, accepting current

changes.

STOP Closes
The Data Entry Window
, discarding current

changes.

1.114 The Edit Text Window ARexx Commands

This window allows the user to set the text, font and point
size of text.
Supported ARexx commands are:

QUERY Returns the string "TEXTED <text>"

TEXT <text> Sets the text to <text>. If <text>is not
defined, clears text from the text box.

FONT <font name> Sets the font to <font name>.

SIZE N Sets font size to N pixels in height.

CONTINUE Closes
The Edit Text Window
, accepting current

changes.

STOP Closes
The Edit Text Window
, discarding current

changes.

Example 7

1.115 Example 7

/* This example ARexx script demonstrates the use of some of
the ARexx commands available for manipulating

The Edit Axis Window
and

The Edit Text Window
. */

address MULTIPLOT.01
’FILE DATA/PLOTME.DAT’
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’COL 1 XCOL’
’COL 2 YCOL’
’CONTINUE’

’AXISADD’
’EDAXIS Y 1’
’SCALE MIN 10’
’SCALE MAX 60’
’GRID BIG 5 1 2’
’GRID SMALL 2 2 2’
’LABEL’
’TEXT LEFT’
’CONTINUE’
’CONTINUE’

’EDAXIS Y 2’
’SCALE MIN 30’
’SCALE MAX 50’
’GRID BIG 5 1 2’
’GRID SMALL 2 2 2’
’POSITION RIGHT’
’LABEL’
’TEXT RIGHT’
’CONTINUE’
’CONTINUE’

’FORMAT BOX’
’SELECT SET 3’
’SELECT ADD’
’LAUNCH’
’YAXIS 2’
’PLOT LINE’
’CONTINUE’

’SELECT SET 4’
’SELECT ADD’
’LAUNCH’
’PLOT LINE’
’CONTINUE’

’SELECT SET 1’
’SELECT REPLACE’
’SELECT SET 2’
’SELECT ADD’
’DELETE’

’REPLOT’
/* end script */

1.116 The Print Set-up Window ARexx Commands

This window allows the user to alter global printing
settings as well as control the printing of plots
individually. The supported ARexx commands are:
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QUERY Returns the string "SETPRINT"

PEN N1 [N2] Sets the N1st pen to N2 points wide. Multiplot
uses the pen concept borrowed from pen plotters in which
each pen can be set with an individual colour and pen width.

GRAPH ON|OFF Controls the rendering of the currently active
graph.

ON Ensures the currently active graph is printed when
the PROJECT/Print menu option is selected.

OFF Prevents the currently active graph being
printed.

SPOOL ON|OFF Switches on or off the print spool.

MODE COLOUR|COLOR|B&W Sets the print out to either colour
or black and white.

COLOUR Prints in colour.

COLOR Prints in colour.

B&W Prints in black and white.

CONTINUE Closes
The Print Set-up Window
, accepting current

changes.
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